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4.1 Code Editing Input and

System Compilation

4.1.1 Design File Edit and Input

- - T i r-. T iy = b Al ] =1
£3 New %J L'i] = = Temy =
-‘ﬁ Home
" enOmisEPeed .|| F®&T == eewpll HFE [Mnmna o emoEr i

i 1 module CNT10 (CLE,RST,H = s - LT

il F'IES_ 2 input CLK,EN,RST, Ld o b z :
AHCL File 3 input [3:0] DATA : 555%@9@@ |_|CNT10w 2017/5/6 21:07 ¥
Block Diagram/Schematic File 4 output [3:0] DOUT
EDIF File 2 SIEEERIE SOUE . "
Qsys System File 7 szﬁg— r-néuglr Q1 HE
State Machine File g8 always @(posedge CI
SystemVerilog HOL File 9 ? begin <

Lt 10 if (!RSI =

d .Scrlpt F"E, il else if (EN) bd B
Verilog HOL File 12 if (!LOH
VHOL File 13 else 1if (Q1 l.

4 Memory Files o ig . else Q1 <3 SHE

i . - 2n

Hexadecimal (Intel-Format) File - ki G _
Memory Initialization File 17 if (Q1=—4'n3) cdq {.;

4 Verification/Debugging Files 18 sndimochile -y
In-System Sources and Probes File = : F i v
Logic Analyzer Interface File

; CHTI0. v =

SignalTap II Logic Analyzer File SpEE W | e _ E
University Program VWF REREM: [y . =

Figure: Select edit file type Figure: Edit input source program and save it

Any EDA design is a project, and you must firstly create a folder for this project that holds
all the design files associated with the project. Different design projects are best placed in
different folders, and all files for the same project are in the same folder.



EDA Lap
4.1 Code Editing Input an

System Compilation

4.1.2 Creating a Project

&4 Mew Project Wizard

Directory, Name, Top-Level Entity [page 1 of 5]

What is the working directory for this project?
D:\MY_PROJECT

What is the name of this project?

0 @

CNT10
Fine_pitch Ball Grid Array What is the name of the topJevel design entity for this project? This name is case sensitive and must exactly match the entity name in the design file,

CNT10

|Use Existing Project Settings. .. |

Figure: Creating project CNT10 using New Project Wizard

23 _. €4 New Project Wizard

=

€4 New Project Wizard

Family & Device Settings [page 3 of 5] EDA Tool Settings [page 4 of 5]

Select the family and device you want to target for compilation. Spedify the other EDA tools used with the Quartus IT software to develop your project.

You can install additional device support with the Install Devices command on the Tools menu.

EDA tools:
Device family Show in "Available devices' list
. | Tool Type Tool Name Format(s) Run Tool Automatically
Family: |Cydone 1V E ~|  Padage: [Faca =) Design Entry/Synthesis |<Nane> v| <Mone > Run this atically to synthesize the
Devices: | Al Pin count: |484 '] Simulation |MudEISim—AItEra - " Werilog HOL - | Run gate-level simulation automatically after compilation
Speed grade: i8 - |

Target device
Board-Level Timing | <None: |

Mame filter:
‘ Symbal | <None>

@ Specdific device selected in 'Available devices' list /| Show advanced devices

) Auto device selected by the Fitter

Signal Integrity | <MNane >

Boundary Scan | <None: |

|
Formal Verification | <Mone > ‘

Other:

Available devices:
T

| Name Core Voltage LEs User 1/0s Memory Bits Embedded multiplier 9-bit elements PLL mICk; Figu re: Design and Ve rification tool Selection

EP4CE1SF23CE8 L2V 15408 344 516096 112 4 20 |

‘EP-1CE30F23CS L2y 28848 329 608256 132 4 n |
EP-1CE-1DF23CS L2y 39600 329 1161216 232 4 20 ‘
‘EP4CE55F23C8 Lav 55856 325 2336160 308 4

Figure: Select the target device EP4CE55F23C8




4.1 Code
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4.1.3 Constraint Item Setting

€4 Quartus I 64-Bit - Dy/MY_PROJECT/CNT10 - CNT10
" Settings - CNT10

Assignments
—Settings —
More
Settings

Assignments
—Device

w Lab

Editing Input an

Qe

Project Navigator

| éy Cycione Iv E: EP4CESSF23q
BB enT10 S

FRT

&% Hierarchy
Tasks

Flow: | Compilation

4 = Compile Design
> @ Analysis &

[=[=] = l

Category:
General Analysis & Synth
Files
Libraries Spedify options for|
4 QOperating Settings and Conditions affect VOM or EDI
Voltage
Temperature Optimization Ted
4 Compilation Process Settings Speed
Early Timing Estimate
Incremental Compilation @ Balanced
Physical Synthesis Optimizations ) Area

[ 3

EDA Tool Settings
Design Entry /Synthesis
Simulation
Formal Verification
Board-Level

Analysis & Synthesis Settings
WHDL Input
Verilog HDL Input
Default Parameters

J Timing-Drriven §
[¥] Power-Up Don|
| Perfarm wysT

PowerFlay power

|More Settings...

' More Analysis 8 Synthesis Settings

=

Specify the settings for the logic options in your project. Assignments made to an individual node
or entity in the Assignment Editor will override the option settings in this dialog box.

Existing option settings:

| MName:

iAIIow Any RAM Size For Recognition

:Allnw Any ROM Size For Recognition

| Allow Any Shift Register Size For Recognition
;.-'-\Ilo'.l\' Shift Register Merging across Hierarchies
| Allow Synchronous Control Signals

| Analysis & Synthesis Message Level

Auto Carry Chains

| Auto Clock Enable Replacement

;Auhn DSP Block Replacement

| Auta Gated Clock Conversion

| Auto Open-Drain Pins

| Auto RAM Block Balancing

Figure: Select compilation synthesis work mode
EN

off
Off
off

Auto

On

Medium

on
on
On
Off
on
On

Setting: «|

m

&4 Device

Select the family and device you want to target for compilation.

You can install additional device support with the Install Devices command on the Tools menu.
Device family Show in "Available devia
Family: |Cydaone IV E - Package: FBGA

[= Al Pincount:  [484
Speed grade: |8
Target device
Name filter:
Auto device selected by the Fitter

7| show ad d d

@ Specific device selected in 'Available devices' list s advane=t

e Device and Pin Options. .

Available devices:

| Name Core Voltage LEs User I/0s Memory Bits Eml

| EP4CE15F23C8 1.2V 15403 344 516096 112

EEP-1CE3EIF23CB 1.2V 28848 329 508256 132

EP4CE40F23CE8 1.2V 39600 329 1161216 232

|EP4CES5F23C8 1.2V 55856 325 2396160 308

#4 Device and Pin Options - CNT10

Category:

General
Configuration
Programming Files
Unused Pins
Dual-Purpose Pins
Capacitive Loading
Board Trace Model
IfO Timing

Voltage

Pin Placement

Error Detection CRC
CvP Settings

Partial Reconfiguration

Dual-Purpose

Specify how dual-purpose pins should be used after
settings for each pin depend on the current configu
which is: Active Serial

Mote: For HardCopy, these settings apply to the FF

Dual-purpose pins:

| MName
|DcLk

[pataro)
|pata[11/AsDO
|Datal7..2]

|FLASH_nCE/nCs0Q
|Other Active Parallel pins

|ncED

Use as programming pin
As input tri-stated
As input tri-stated
Use as regular 1j0
As input tri-stated
Use as regular IjO
Use as programming pin

Figure: Select the target device and operation mode
(1) Select compilation constraints. (2) choose the way to configure the device. (3) choose

configuration device and programming mode. (4) select the target device pin port state.
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4.1.4 Synthesis and Compilation

€4 Quartus II 64-Bit - Dy/MY_PROJECT/CNT10 - CNT10

File Edit View Project Assignments' Processing Tools ndow Heln )
B~ B AT [onTio v [x]® @ P GO S @ $ A e 9
|Praject Navigator 1;1 F X I »ﬁ« Home: | \.Q Compilation Report - CNT10 [
i Entity Loglc Cells d LogicF IjO Rt Tahle of Contents 4
e
‘_\ Cydane IV E: EP4CES5F23CE! 2 Flow Summary iFIow Status Successful - Tue May 23 10:36:07 2017
| uj CNT10 5\'@ 2@ 404 0 () =1 Flow Settings | Quartus II &4-Bit Version 13. 1.0 Build 162 10/23/2013 51 Full Version
| g Revision Name CNT10
‘ B8 Flow Non-Default Global Set{ Top-evel Entity Name i
| 4 1 » 58 Flow Elapsed Time Family Cyclone IV E
| e o ] W i
. | iy Herarchy | E|Fles | o+ DesignUnits ! e EH Flow OS Summary Device EP4CES5F23C8
P rocess I n g - L —— e % Flow Log Timing Models Final
) . Tasks RE x| 7 Analysis & Synthesis Total logic elements 9/55856 (< 1%)
Sta rt Com pl Iatlon I |Com e = ‘ [ : ] S G Fitter Total combinational functions 9/5585% (< 1%)
EE A st ; Dedicated logic registers 4/55,856 (< 1%)
- Task - ' L Assembler Total registers 4
: ; ‘ > |1 TimeQuest Timing Analyzer | |Total pins 13/325(4%)
o 4 B Compie Design '3'-; . 7 EDA Netlist Writer Total virtual pins 0
o > B Analysis & Synthesis oc} = \I) Flow Messages Total memory bits 0/2,396,160 {0 %)
o > B* Fitter {(Place & Route) o () Flow Suppressed Messages Embedded Multiplier 9-bit elements 0 /308 {0 %)
o » @ Azsembler (Generate programming files) OC Total PLLs 0/4{0%)
o > @ TimeQuest Timing Analysis o s
a4 T 12 4 114 13
|
=l —
A DRI v
q Type 1D Message

\i) 204018 Generated file CHT10_8_
4) 204015 Generated file CHT10 min

1200mv_Oc_slow.vo in folder "D:,-’I-IY_PRDJECT;’sirr.'.zlation,-’qsirr.,u’,-’"
1200mv_0Oc fast.vo in folder "D:,-"HY_FRDJECT;’.Sirr.alationfqsirr.,f,f'" for EDA simulation tool

for EDA =simulation tool

Figure: Report information after the entire compilation is error-free

Compilation includes Quartus II's multiple processing operations on the design input, including input file
troubleshooting, netlist file extraction, logic synthesis, adaptation, and assembly files (simulation files and
programming profile) generation, and timing analysis of the project.
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4.1.5 Application of RTL Viewer

caTa[R. 0]y

LoaD [

N =3 o = - 3
] s
o 1'h0 o _ L1~
. g ; — ._E'r
1]3..0] 415 oz N cout
— [ pouTz..0)
ak[ > aK: g
EM [ *E
ar
RST[

Figure: RTL diagram of the CNT10 project

Select the Tools — Netlist Viewers
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If using Modelsim:

-
&4 Options B |
Category:
4 General EDA Tool Options
EDA Tool Options
Fonts Specify the location of the tool executable for each third-party EDA tool:
Headers & FDDtEF_E_SEtﬁngs EDA Tool Location of Executable
4 Internet Connectivity —
MNotifications Precision Synthesis = |
Libraries Synplify =
License Setup 3 ——
Preferred Text Editor Synplify Pro |_J
Processing Active-HDL | |
Tooltip Settings Riviera-PRO )
4 Messages
Colors MﬂdEISlm | van |
Fonts Questasim s
ModelSim-altera E:\alteral13. 1'\modelsim_asewin32aloem [I]

Figure: Viewing the Quartus Simulation Tool Path to Modelsim Simulation Software

Make sure the simulation tool in Quartus II points to the path where Modelsim is located
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4.2 Timing Simulation

(1) Open the Simulation Waveform Editor

£9 New

L)

CNTI10.vwft

T
{4 Simulation Waveform Editor - Dy/MY_PROJECT/CNTI0 - CNT10 - [Waveform1.vwd]

Mew Quartus II Project

4 Design Files
AHDL File
Block Diagram/Schematic File
EDIF File
Qsys System File
State Machine File
SystemVerilog HOL File
Td Script File
Verilog HOL File
YHDL File

4 Memary Files
Hexadecimal (Intel-Format) File
Memory Initialization File

4 Verification/Debugging Files
In-System Sources and Probes File
Logic Analyzer Interface File
SignalTap II Logic Analyzer File
University Program VWFE

m

Fl=  Edit View Simulstinn  Hsln ==V1
[}_]%mﬁﬁrhi)@)@%)@ﬂﬁ)@” m':':lig,??:

Master Time Bar: 0 ps [IH 4 |F'|:|inter: 387.6ns Interval: 337.6ns

0ps 160.0ns 320.0 ns 430.0ns
lue [ . |

Mame 0ps Jps

Figure: Vector waveform file edit window

File->New->Vector Waveform File-> Zoom ->Fit in Window
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(2) Set the simulation time

e N——— — —_—

£4 Simulation Waveform Editor - D:y/MY_PROJECT/CNT10 - CNT10 - [CNT10.0wd]

=
5080 N Z N E B O E 2 R S eY 2 [
Master Time Bar: 0 ps | 4 | | r | Fointer: 97.0ns Interval: 97.C
Ops 5.12us 10.24us 15.36us 20.43us  25.E
i Yalue at ] 1 1 1 1
0ps Ips
- T ™
£4 End Time 2R
Set End Time
End Time: 55.0 |u5 - |
[ Ik, ] l Cancel ]
L -
T

Figure: Set the simulation time
Edit-> Set End Time (usually 10~100 us)
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Use Node Finder to select the signal nodes into the waveform

: P ——— ] -

I - D:/NULT_DENO/NULTAE - WNULT4AE - [Vaveforml.vefs] Mot Time Bar —y T Cuushommzs | -{ vt

LIl Eroject Assigoaents Precessing Joels Mandow Help P o) ook o [N =] _| % inchate sbartim: =

B reosec oo | L] | |t e

) rs1 Sereen Curl#Al 4Space O - . R o e T =
150 1< Console Al e#2 joul @r L1l il Bt Ui s -

E Fit in Yindow Cirl¥y ﬂ Bezzages A3 ::u IL-::: ::: -:::::

@ Zoom In CultSpace I8 Status ALt - Untesiged  WeutGoop  User arsesed

@ Zoom Qut Crl4Shif4Space @ Chunge Bamager  ALUS o e . e

2408 Q Tosks ALL46 _Tb':'. Unstsred o eep— . v

Figure: Open Signal Node Query Window Figure: Drag the signal node into the waveform editor

If the node name is not displayed, compile once again, and the signal nodes
will be shown.
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Join signal nodes needed for

simulation
O b E NI OE WY B TR R e 2 [ERY

il 1 s
Node Find | %
0 ps 1 b | Pointer: 5.3ns flds s E——
0ps 20.0 s 160.0 ns 240.0nd | Mamed: = Filter: |Pins: al G I l Ok ]
Value at i ] |
0 p3 | . i
P € Insert Node or Bus % || Lookin: D I List ] I Cancel |
Modes Found: Selected Nodes:
Mame: 3
Ame \L' Mame Type - Mame Type
Type: | NPUT [ e ||| | ax Input in_ gk Tnput
out 2| ot
Value type: [3-4eve = 24 cour Output | D_ 24 cour Output
Node Finder. .. '% DATA Input Group = == '% DATA Input Group
Radix: Bi ;
adv:  [Binary ) i DATA[D]  Input = |2 pour Output Group
Bus width: 1 In_ DATA[1] Input 4 n_EN Input
in in
Startindex: @ - DATA[Z] Input > LOAD Input
'L DATA[3] Input 'L RST Input
Display gray code count as binary coun au
==y DOUT Output Group

H =44 pout(o] Cutput

Figure: Join signal nodes needed for simulation

Radix -> Hexadecimal
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Setting the
bus data
format

Setting the
clock
parameters

£4 Simulation Waveform Editor - Dy/MY_PROJECT/CNTLO0 - CNT10 - [CNT10amwf]*

Master Time Bar: 0 ps

=

D % o & Z T E I XE BT MR w2 e 2 [=])8%

Ll | 13 |Pointer: 131.42ns Interval: 131.42ns

0ps 5.12u &4 MNode Properties I. % | 30.72 us
Mo Value at = 1 :
0ps 0 ps —
Mame: Doum [ (8.4 |
5. OK  BO Type: [outPUT = r———
| | concel |
I% > DATA  HO Value type: |9-1level Y
in,_ = EO Radix: |Hexadedmal - |
M, LOAD EO Bus width: |4
iB_ RST B0 || Display gray code count as binary count
o CouT BX i
£ - DOUT B XKKX 2L
I
|0 ps 5.12us 10,24 us 15.36 us 20.498 us 25.6us 30
N Value at [ 1 1 1 ; 1
ame 0 0ps r T 53 T
ps : &y Clock e i
in
T CLKE BEO ﬂ_ﬂ_ﬂ_ﬂ_ﬂ_ﬂ_r Base waveform on time period mrl_ﬂ_ﬂ_
i .
%= | DATA HO Period:  900.0 s~ g
in
b EN BO Offset: 0.0 ns -
in
- LOAD B0 Duty cyde (%6): 50 =
in_ RST BO
oM COUT BX Lok J[ canel |
= DOUT HX b ’ X

Figure: Setting clock parameters
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gﬁf

"

EET“

QEH

i
LIS

Mame

CLE

- DATA

EM

LOAD

RET

cout

- DouT

Value at | |

0ps

B0
HO
BO
B1
B1
BX

HX

MName
= CLK
[B | o DaTA
i EM
. LOAD
?Ek RST
| cut
Y couTt
|24 » pour

Value at
0ps

EO

HO

EO

E1l

E1

=

HX

5.12 us 7.68 us 10.24 us 12.8 us
1 1 1

Figure: Editing the excitation waveform

5.12us
1

7.68 us
1

10,24 us 12.8 us 15.36 us 17.92 us
1 1 1

L

L

F 1]

(ED ST IS G AT ER B 40D 410 &) TN (ER B 406 S &S IR,

Figure: Waveform file for simulation output
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4.3 Hardware Testing

4.3.1 Pin Assignment

digiton8  digitron7  digiton6  digitronS  digitrond  digitron3  digitron2  digitron1
Table 4-1 Pin Locking Based on EP4CESSF23C8 (Available from the List of Appendix A.4)
PIO19-PIO16 SPEAKER Counter signal
PIO23-PI020 S CLK EN LOAD RST DATA(3) | DATA(2) | DATA(1)
PIO27-PIO24 i dnaéne_. 5
PIO31-PIO28 ode 0 circut . ; S _— - P P
55 F10 5 conirol Key 8 Key 7 Key 6 Key 5 Keyl:D4 | keyl:D3 key1:D2
PIO39-PIO36 —
PIO43-PIO40 Moo 0 e PIO7 PIO6 PIOS PIO4 PIO11 PIO10 PIOS
PIO47-PIO44 & Slgnald_
orresponding | .
— 1 LOcKO  FPGA/CPLD FPGA pins AB6 X7 AA6 AB3 ABS AA3 W2
—CLOCK2  Target chip =
—CLOCKs Counter signal | 170 (0) COUT | DOUT(3) | DOUT(2) | DOUT(1) | DOUT(0)
—CLOCK9 name
Mode 0 cireuit . Digital 2:a i - . .
gg?_lpg?ég conirol Key 1:D1 e Digital 1 | Digital1 | Digital 1 | Dagital 1
PIO15-PIO12 M"d;gon‘;‘fc”“ PIOS PIO20 PIO19 PIO18 PIO17 PIO16
Corresponding . 5 ; ;
FPGA pins uz2 AAl N2 W1 R2 U1l

ircuit configuration
0.0

Figure: Experimental Circuit for FPGA in Mode O

Experimental Circuit for FPGA
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4.3.1 Pin Assignment

@ Locah:ns
4 Ct:urh el

+  Information: | This cell specifies the entity or node you want to assign to the location specified in the L

= X
Edt: ¥ |
A To Location Enabled
~ ! | » Hode Finder. ..
g Select Assigaent Group

Figure: Locking the pin of the FPGA by using the Assignment Editor

Assignments->Assignment Editor->Locations or PIN planner

To: the port in the program
Location: the pin on the board, such as PIN_23
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|4 CLK
|28 couT

% DATA[3]

, [

% DATA[Z]
|| DATA[1]
| 1% DATA[O]

i?”% DOUT[3]
i?“l, DOUT[Z]
i?“% DOUT[1]
|24 DOUT[0]
o, EN

in_ LOAD

o RsT
|

! Mode Name
|

Direction Location 10 Bank
Input
Output
Input
Input
Input
Input
Output
CQutput
Output
Output
Input
Input
Input

YREF Group

Figure: The newly opened Pin Planner window

Fitter Location Mode Mame
PIN_34 in Ok
PIN T8 ot CoUT
PIN_R8 in_ DATA[3]
PIN_R 10 in_ pATA[Z]
PIN_T3 in_ DATA[1]
PIN_V& in_ DATA[O]
PIN_RS 29 pouT[3]
PIN_TS 24t pouT[2]
PIN_R& St DOUT1]
PIN_P8 24t poUT[o]
PIN_T7 in_ EN
PIN_R7 i|'1>_ LOAD
PIN_P4 in_ RsT

Direction

Input
Cutput
Input
Input
Input
Input
Cutput
Cutput
Cutput
Cutput
Input
Input
Input

Location

PIN_AB6
PIN_AA1
PIN_ABS
PIN_AA3
PIN_W2
PIN_U2
PIN_V2
PIN_W1
PIN_R2
PIN_U1
PIN_Y¥7
PIN_AAS
PIN_AB3

Figure: After pin locking is completed

After locking the PIN, you must compile the project again, Start Compilation
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4.3 Hardware Testing

4.3.2 Compiled File Download

@ Programmer - Diy/MY_PROJECT/CMT10 - CNT10 - [output_files/CNT10.cdf]

S e — Help 5

‘:ﬁ Hardware Setup... | UISE-Blaster [USE-0]

[] Enable real-time ISP to allow background programming (for MAX II and MAX V devices)

Mode: @

(T T File Device Chedksum Usercode Program/ Verify Blank- Examine Security  Erase ISP
el Start | Configure Chedk Bit CLAMP
o output_files/CNT10.50f  EP4CESSF23 002B5710  002B571D il
3 Auto Detect |
Delete

[ AddFie... |

Al D= Fila

[*} Add Device...

T Up 4
o

EP4CESSF23

DO

Figure: Select JTAG programming mode to configure SOF file into FPGA

Download SOF configuration file into FPGA. Install the driver and find the hardware device.
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»';b Hardware Setup

Hardware Settings ~ JTAG Settings

Select a programming hardware setup to use when programming devices. This programming
hardware setup applies only to the current programmer window.

Currently selected hardware: | USB-Blaster [USB-0]
Available hardware items

Hardware Server Port | [Add Hardware, .,
USB-Blaster Local UsSB-0
R aminvee HarAwars

Figure: Add a programming download method
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4.3.4 USB-Blaster Driver Installation

m  One end of the USB Blaster programmer into the USB port of the PC. A USB
driver dialog box will pop up.

m Seclect the user to search for the driver according to the dialog guidance.

m [t is assumed that the Quartus II software is installed on the E drive and the
driver's path is E:\altera\quartus\drivers\usb-blaster.

D:\altera\quartus90\drivers\use-blaster



4.4 Circuit Schematic
Design Flow

4.4.1 Half-adder Design

A A B so | co A _|
= /)D > 0 0 0 0 E i
ﬂ co 0 1 1 4] oo I_‘
‘_/ 1 (4] 1 (4]
1 1 4] 1 50
Figure: Circuit Figure: Truth table of half adder Figure :Simulation function

structure of a half-adder

SO=A®B; CO=A-B



4.4 Circuit Schematic
Design Flow

5| Symbol

Fiaviiz | N A e N T

d: B e al s carisfieanesl (WG e e S R
© £3 megafunctions G s S S B R
» 1 others

> £ primitives

Zoom F J }
Mame:
shey ’ input IZ]
Inzert Symbol. . . [] repeat-insert mode b T B B B R b S B BB AR
Synbol as Elock... Tnsert symbol as block L
..
A |

Figure: Select Open Component Entry Window Figure: Input Pins in the Component Input Dialog Box
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4.4 Circuit Schematic
Design Flow

eS8 Edit View Project Assigiments Processing Toels Window Help

[ Hew. .. Ctrl+H At <] WMo @BQ DI wH 2 B 4 e
e & Open. .. Ctrltd |
= Clese Critpy | Padderhdl ]
SR

e e L e S e o

I:é @ Few Froject Wizard. .. PA
%‘:h Dpen onject. N Ctrl.l.:l' AR R e K 3 K W e S o 5, i pm s s i, A
Convert MATFPLUS TT Froject. .. e

Save Project

Close Froject

; '-Ii:IU-:l:-PU:l:- e remmmme . am— C.If]. e e mmme e m——————— E

Save As. ..

Fla

File Properties. ..

Create § Update Create HOL Design File for Current File

Export. .. Create Symbol Files for Current File

Conwert Frogramming Files. .. Create AHDL Include Files for Current File

Figure: Complete design and pack the half adder as a component for calling in
higher level design



4.4 Circuit Schematic
Design Flow

4.4.2 Top-level Design of Full-adder

4] Symbol

Hew Project Wizard: Directory, Name, Top-Level Entity [pag...

Libraries:
4 [ Project
= £ h_adder
—4 4 [ difalteraf13. 1/quartus/libraries/
Vhat it the raene of this propset * & megafunctions
R e » 23 others
_I_m B 4 [ primitives
> 3 buffer
what i the name of the lop-lewvel design ently For thes peogect? Thes name i case tendlive and must 4 & logic 2l N
eancty match the enbly rume in the deagn fle £t and12 A BOME:
| £} and2 = o B co —

ft_addes et F ) ‘
§ it

m| »

what i the wodong deectony lor thes propect?
[0 7aDDER

MName:

h_adder |:J

Figure: Add a half adder to the f_adder project

Lze Exashng Prosect Seltrg

Figure: Full adder f _adder.bdf project settings

h_adder

énet'l
' U3

80—t
CO —— —+—1B

cout

L_J'] inst l_J2 insta

RELIT
WG

i cin

Figure: Full adder f_adder circuit diagram




4.4 Circuit Schematic
Design Flow

gf@mi%ﬂﬂle% SSlmulatlon and Hardware Testing

0 ps E.EI.fu us 5. 1? us [}
16.5 ns
J
aln __I
bin
c1n |_
cout
s | [ L[] A

Figure: Simulation waveform of the full adder
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4.5 Pin Assignment Using

Attributes

Direct control of pin locking in Verilog code

|Example]
module CNT10 (CLK,RST,EN,LOAD,COUT,DOUT, DATA) ;
input [3:0] DATA /* synthesis chip pin="ABS5,AA3,W2,U2" */;

output [3:0] DOUT /* synthesis chip pin="V2,Wl,R2,Ul" */;

output COUT /* synthesis chip pin="AA1" */;
input CLK /* synthesis chip pin = “ABE" */;
input EN /* synthesis chip pin = "¥7" *f -
input RST /% synthesis chip pin = “AB3™ */;
input LOAD /* synthesis chip pin = "RA6" */;

m (1) It must correspond to the determined target device, and the attribute
statements in this book apply only to Quartus ll;

m (2) It can only be defined in the top-level design file.



